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ICT Module Map 

 
 
 

Information about the module 

This module will provide you with a solid grounding on how best to use technology in the 
world of work and tertiary education. While the skills and knowledge you will learn here can 
be applied broadly to all avenues of life we have fashioned them specifically to support you 
complete the Skills for a Changing World programme. Consequently the word processing 
skills you will learn in this course will be used later in the language course, spreadsheets will 
come in handy during some of the Maths exercises while your presentation skills will be 
needed in the YGPS module. We have ordered the lessons in an attempt to provide you with 
the right skill at the right time so follow the ICT Module section order to stay in ‘synch’ with 
what is happening elsewhere in the programme. 
 
As an additional outcome our module you will enable you to construct your own electronic 
portfolio on CD-ROM. This electronic document will contain your best work from each ICT 
module sections as well as reflect your taste and interests. This document also contains a 
short CV so it can be used to persuade prospective employers when you are looking for a 
job or wanting to start a career.  

What is this module about? 
This module will introduce computers and other ICTs (Information and Communication 
Technologies). While you will have a little theory to familiarise yourself with, most of the 
course is practical and will require you to practice various computer skills. We will use mostly 
practical sessions in the computer room rather than lectures or tutorials. There will also be a 
healthy dose of self directed study when you will be required to practice your new skills or 
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use the programs to find out additional information. For this you will need to be able to 
access the institutional computer room after the allotted time allocated to official practicals 
and tutorials. Access to a computer at home would also be beneficial although is not a 
compulsory requirement. 

What will you learn? 
Each section part has its own outcomes which are stipulated at the beginning of each 
lesson. However, at the end of this module you are expected to show evidence that you 
have achieved the following main learning outcomes: 
 

My learning journey 

What I am expected to know and do  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Demonstrate a basic knowledge of how the 
computer system works,  

  

Describe the parts of a PC using the correct 
terminology. 

  

Log into the institutional network   

Demonstrate competency at creating and 
presenting a PowerPoint presentation. 

  

Demonstrate competency at writing and editing a 
word processor document. 

  

Demonstrate competency at creating a spreadsheet 
document 

  

Demonstrate competency at receiving, writing, 
sending and storing e-mail correspondence.  

  

Demonstrate competency at interacting with 
members and extracting information from Social 
Networking Sites 

  

Demonstrate an ability to search competently for 
information on the Internet 

  

Demonstrate an ability to search competently for 
information using online and multimedia 
encyclopedias 

  

Demonstrate an ability to correctly reference sources 
extracted from ICT sources using online citation 
tools. 

  

 

How much learning time do you need? 
This module carries 16 credits. It should take approximately 160 hours to successfully 
complete the module. This includes contact session time with your facilitators and tutors, 
reading time, your own research time and time spent on doing the assessment activities.  
 
A Time Check is included at the beginning of each module. It is a useful time management 
tool as it shows how much time you are expected to spend on each of the sections and it 
allows you to record how much time you actually spent.  
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TIME CHECK 

Sections Suggested time input Actual time spent 

1. Orientation 20 hours  

2. Introduction to ICTs 27 hours  

3. Presenting Information and Portfolio 
Work 

23 hours  

4. Assignment Writing using a Word 
Processor 

30 hours  

5. Data Processing with Spreadsheets 26 hours  

6. Communication with e-Mail and Social 
Networks 

21 hours  

7. Researching Skills using ICTs. 13 hours  

       Total 160 hours  

How will you learn? 
This module, like the whole of the Skills for a Changing World Programme uses different 
ways of learning. Experienced facilitators will guide and support you throughout the 
programme. They will plan and organize suitable contact sessions during which you will use 
the student guide and various other learning materials.  
 
Trained tutors will further help you with individual and group learning activities. By working 
with your fellow students on group activities you can give each other support and learn 
important teamwork and communication skills. 
 
Much of what you will achieve depends on your own effort and commitment. The most 
successful students are not necessarily the cleverest or the most experienced, but rather 
those who are most disciplined, most organised, most willing to reflect critically on their own 
learning, most able to practice what they are learning, and most successful in managing 
their time.  
 
To support you in your learning in the ICT module, there are two kinds of learning resources 
that you can use – a Student Guide, and a Resource CD. Each of these learning resources 
has a specific purpose: 
 
The Student Guide outlines the learning path for the ICT module and provides you with 
basic information, guides you through activities and stimulates you to ask questions, find 
answers and share what you learn with your fellow students. The information in the Student 
Guide is not a sufficient source of learning in itself. You, the learner, have to complement 
the information contained in the Student Guide by reading, researching, discussing/debating 
and reflecting. Only then will your learning be an enriching experience. 
 
The Resource/CD contains a number of electronic materials that are part of your learning 
path outlined in the Student Guide These materials include multimedia tutorials, word 
processor templates and exercise files, presentation templates and spreadsheet activity files. 
You will be required to access these documents from the CD at the appropriate time as 
stipulated in the guide. 

How will you be assessed? 
In the ICT module you will be assessed in two ways: individual assessment tasks after each 
section and also through the submission of a completed electronic portfolio for an overall 
semester mark: 
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All section assessment tasks and tests (7 in total) will be marked individually after the 
completion of each section. These tasks are worth 10% of the final module mark. The 
student then has the prerogative of revising these documents before storing them on an 
electronic portfolio prepared by themselves and the focus of Section 3 activities. The 
portfolio will also store any additional work generated by each student in the other modules 
where there is an overlap. Besides a repository of work the portfolio also contains a student 
journal for self reflective activities, a student CV, personal profile that includes collected 
media etc. The portfolio will be taken in for marking and will be allocated 30% of the 
students ICT Module semester mark. 

How to find your way in the student guide 
This guide is prepared especially for you. It contains all kinds of activities that invite you to 
take an active part in learning important skills and behaviours that will help you to be 
successful not only in this programme but that will also prepare you for your future role in 
the world of study and work. Learning can be an exciting adventure when you start doing 
things for yourself. 

Icons 
Icons are visual ‘signposts’ that give clear signals of what is expected of you. The following 
icons are used in the Student Guides for all the modules. You will soon become used to 
recognising each icon and the message it conveys. 
 

 

LEARNING ACTIVITY 

When you see this icon, you will know that you have to do an activity to show 
how well you understand what you have read and learned. For some of the 
learning activities the writer will include some comments or advice. These 
comments should never be read before you have completed the preceding 
activity. These comments are also not intended to provide the final ‘answer’, 
since your opinion may be completely different from the writer’s and still be 
acceptable. The writer is simply providing you with an informed opinion. 

 

GROUP ACTIVITY 

Whenever you see this icon you will know that you will work with some of 
your fellow learners on a team activity. 

 

ASSESSMENT ACTIVITY 

This is the sign for assessment activities that you will complete and include in 
your portfolio. All these activities are marked by the facilitator and they will 
contribute to your total mark for the programme. 

 

RESOURCE FILE 

When you see this sign you will know that you need to refer to the resource 
file/CD. It contains additional readings and articles that you may be asked to 
use to complete an activity. 
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Module Sections 
Section 1: Orientation 

• Computer Room Usage 
• Basic Operations 
• Terminology 
• Electronic Portfolio 
• Assessment Task 

 
Section 2: Introduction to ICTs 

• Hardware I 
• Hardware II 
• Software I 
• Software II 
• Networks 
• Assessment Task 

 
Section 3: Presenting Information & Portfolio Work 

• Structuring Your Presentation 
• Inserting Media and Graphics 
• Presentation Interactivity 
• Assessment Task 

 
Section 4: Assignment Writing with a Word Processor 

• Writing and Typing Skills 
• Formatting your Assignment 
• Inserting appropriate Media and Graphics 
• Using Tables 
• Reviewing, Proofing and Printing 
• Assessment Task 

 
Section 5: Data Processing with Spreadsheets 

• Spreadsheet Orientation 
• Formulas and Functions 
• Graphing a Trend 
• Assessment Task 

 
Section 6: Communication with e-Mail and Social Networks 

• Setting up a Webmail Account 
• Organising your e-Mail Program 
• Forming or Joining an Online Group 
• Assessment Task 

 
Section 7: Research Skills using ICT 

• Finding Information Online 
• Online and Multimedia Encyclopaedias  
• Referencing Sources and Copyright 
• Assessment Task 
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Glossary 

 
Special terms and phrases used in this learning guide are explained here.   
 

WORD EXPLANATION 

Input The action of inserting data into a computer system 

Output The action of extraction information out of a computer system 

Processing The action of manipulating data to be able to turn it into something 
of meaning. This is normally done by a computers Central Processing 
Unit or processor. 

Portfolio A collection of work presented as evidence of the students 
proficiencies.  

Mainframes Very large computers used by companies such as banks to process 
the thousands of transactions that take place daily 

Hardware Components of a computer system you can touch 

Software Components of a computer system made up of machine code for 
example programs 

Microcomputers Very small computers such as cell-phones or watches that have a 
specific function 

Peripherals Devices that are attached to a computer system 

Ports Openings on a computer system that allows a peripheral to be 
attached to the computer and by which communication between the 
peripheral and the computers takes place 

Operating System System software essential to the running of a computer system as it 
coordinates the interaction between hardware and software 

Byte A measurement of binary code. 1 byte is made up of 8 bits. 

Megabyte A measurement of binary code. 1024 kilobytes is 1 Megabyte. The 
abbreviation MB is used to denote a Megabyte 

Application Software Software that is customised for a user to employ. Software like a 
word processor or spreadsheet is an example of application software 

System Software Software or utilities that are used to coordinate the operations of the 
computer seamlessly behind the scenes. A virus checker is and 
example of system software 

Proprietary Software Software that requires uses to aquire a license to use the code. 
Microsoft is an example of a software manufacturer who distributes 
proprietary software 

Open Source Software whose kernel or core functions does not require the user or 
programmer to purchase the software 

Username A term by which a user is known on a network or social network site. 
It does not have to relate to areal name. 

Password A word, phrase or combination of letters and/or numerals that is used 
to access closed or protected areas of a network or Internet. 

Word Art A graphic option in MS Word to customise the look or your writing. 
Used mostly for titles. 

AutoShapes A graphic option in MS Word that allows the user to insert objects 
that are non alphabetic nor numeral. Squares, Circles and arrows are 
popular 
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Digital Denotes technology that uses binary manipulation of data as opposed 
to analogue. (Computer vs. landline telephones) 

Ribbon The dashboard devise in many Office 2007 applications that 
graphically represents the most common actions. 
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Unit 1: Introduction to ICT. What 
are ICTs? 

1. Introduction 
These should all look familiar to you. Fill in the table by completing the names of these 
various devices and what they are used for. 

 NAME USES 
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The devices in the table are examples of ICTs. ICT stands for Information and 
Communication Technologies, and these ICTs are all around us. We use them every day 
and for so many tasks they are unavoidable. They are often great time savers, although 
sometimes they can also help us waste time. Many people enjoy them because they are seen 
as excellent productivity tools. 

Learning outcomes 
Learners will be able to: 
 

• Identify examples of ICTs that exist in their environment 
• List possible uses for specific ICTs 
• Transfer digital images from a cell phone/digital camera to a computer 
• Identify benefits and problems regarding the use of ICTs 

 
 

 
START UP ACTIVITY 1.1  

 
In groups, make a list of as many ICT devices as you can. 
 

1 Use your past experiences to identify as many information and communication 
technologies that you can think of as a group. Use a brainstorm technique where 
the group lists everything that is mentionedby the members of the group. 

2 Use the block below for your list of ICT examples. Your facilitator will then lead a 
discussion where the group needs to refine your list, removing items from the list 
that do not qualify as examples of Information and Communication Technology. 

3 Now that the group has generated an ‘approved’ list of items, see if you can write a 
definition for the term “Information and Communication 

4 Technologies” in the space provided, which could be included in a technical 
dictionary. 

 
 
Our list of ICTs 

 

 

 

 

 

 

 
 
Our definition of ICT (Information and Communication Technologies) 

 

 

 

 

 



UNIT ONE: INTRODUCTION TO ICT 
 

 

 

5 

SKILLS FOR A CHANGING WORLD Let your future take flight 

What are ICTs1? 
Compare your group’s list of ICTs and definition with the following and see how accurate 
you were. 

DEFINITION: 

“ICTs are the technologies used in the conveying, manipulation and storage  
of data by electronic means.”2 

ICTs should not be considered fixed or static. New ICT devises are being developed and 
being sold daily. If you were to try this same exercise in a year’s time, the list might look very 
different. 
 

Simple Definitions 

Convey: to transport, to carry, to take from one place to another. To communicate; to make known. 
Manipulate: To influence, manage, direct, control or tamper with something to one’s own advantage. 
Storage: A place for storing goods. 
Data: information. A collection of object-units that are distinct from one another. 
 
Wiktionary 

 
 
 

 

GROUP WORK &  
PRACTICAL PORTFOLIO ACTIVITY 2.1 

 
This activity requires you to record instances of information and communication technologies 
(ICTs) that are present on campus, on the route home and in and around your local 
community. 
 
1 Use a digital camera or digital phone camera to photograph examples of ICT devices. 
2 Bring your camera/phone, software CD that accompanies the camera/phone, as well as 

any cables required to class. 
3 If necessary, install the software (your facilitator will assist you). 
4 Download your photographs from the camera to a computer3. 
5 Print out the photographs. 
6 Glue the pictures onto a large sheet of paper leaving enough space to write in a 

description and add labels. 
7 Next to each picture write out the following details: 

a Name of ICT device; 
b Location where device was seen; 
c Reason why you consider it to be an example of ICT. Describe how you believe it 

specifically conveys, manipulates and stores data electronically. 
8 Take a digital photograph of your poster for your electronic portfolio. 
 
There are various ways of transferring images from a cell phone or digital camera to your PC. 
Once you have completed transferring your images to your computer with the help of your 
facilitator, document the steps taken to do so on the following page, so that you may repeat 
this in the future on your own. 
 

                                                      
1 Skills Pack: Refer to pages 13 - 16 for information on computer hardware 
2 See OpenLearn at http://openlearn.open.ac.uk/mod/resource/view.php?id=210525 
3 Skills Pack: Transferring digital images to your PC, see page 11 and 12 
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STEPS in transferring images from my cell phone/digital camera to my computer: 

STEP 1: 
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2.2 Examples of ICTs 
ICTs are all around us; such as: 

• using an ATM 
• phoning home 
• using the World Wide Web at an Internet café 
• playing online games using a PS3 console 
• buying groceries at a supermarket 
• booking movie tickets using the ‘no queue’ kiosk 
• using a satellite navigation system to find your way around while driving 

 
In all these examples data is electronically put into the device, stored, manipulated and 
ultimately transmitted. A simpler model of how all ICTs work is the Input – Processing – 
Output - Storage model: 
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LEARNING ACTIVITY 2.2.1 

 
Complete the following table by filling in the blank cells. Identify input, and output 
components of each device. There might be more than one possible component per device 
so list as many as you can think of. 
 

ICT Device Input component Processor Output component 

Cell Phone Keypad Microprocessor Speaker 

Bank ATM  Microprocessor  

Personal Computer (PC) 
Computer System  Central Processing Unit  

Supermarket Checkout 
Scanner  Microprocessor  

Car Satellite Navigation 
System  Microprocessor  

See the Feedback section later in this lesson to see how well you did. 

 

2.3 Data vs. Information 
It is important that you understand the difference between data and information with 
regard to ICTs, as they are NOT the same thing. 
 
Data: Is the raw material that we would input into an ICT device, such as figures, small facts 
and numbers that, on their own, have little value or meaning. 
 
Information is processed data. That is data that has been reorganized so that it now 
contains some meaning. 
 

 
DATA INFORMATION 

2.4 Benefits of ICTs 
 
Some benefits of ICTs include: 
 
Remember the old day when you had to stand in long queues at the cinema to purchase a 
movie ticket or wait for weeks for mails to arrive at the post office? 
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Now, you can skip the queue and buy your tickets online instead and receive instant 
messages via e-mail. These are some of the benefits of ICTs – how many can you think of? 
Consider how much time and effort ICTs save us on a daily basis and jot them down in the 
space provided. 

 

 

 

 

 

 

 

 

 
 

 
GROUP LEARNING ACTIVITY 2.4.1 

 
Think of a business that you are familiar with. Perhaps it’s the shop up the road or the 
company where a family member is currently employed. Think of ways you could improve 
this business by using computers or other ICT devices. 
 
Write a paragraph4 in the space provided on how you think ICTs might improve the business. 

 

 

 

 

 

 

 

 

 

 

 

 

                                                      
4 English Skills Pack: Mind-mapping, topic and supporting sentences, page 17 
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2.5 Problems concerning ICTs	
  
The cautions that should accompany the use of ICTs are many and continue to grow as ICTs 
develop further. News articles often report on paedophiles who stalk young people in Chat 
Rooms and nasty viruses that can destroy your data and equipment. Consider the following 
examples of such problems regarding ICTs. 
	
  

Virginity sales go online 
May 31 2009 at 10:16AM 
By Hazel Booth 

Earlier this month, an 18-year-old Romanian-born student living in Germany auctioned her 
virginity online in an effort to raise cash for her studies. Alina Percea confirmed that an unnamed 
45-year-old Italian businessman paid her £9 000 (R108 000) to sleep with her. 
 
http://www.iol.co.za/index.php?set_id=1&click_id=3&art_id=vn20090531015723343C538583 

	
  

'Beware of rising ATM fraud' 
September 12 2008 at 08:29AM 
By Christina Taylor and Devin Hermanus 

Police are warning the public to be careful at ATMs, with cyber crimes such as bank card 
"skimming" on the rise. 

Superintendent Jerome Hardenberg, SAPS Crime Prevention Awareness officer in the Western 
Cape, told a media briefing on Thursday that card "skimming and copying" devices and card-
reading software were being brought into the country by organised crime syndicates which 
identified a market. 

"It's a definite cause for concern because there has been steady flow of this kind of crime." Card 
skimming involves swiping a stolen card through a small hand-held device, recording the card's 
information. 

Hardenberg said skimmers working in teams can distract ATM users with offers of assistance, then 
quickly take a card and pass it behind their backs. An accomplice will then skim and return it 
without the victim being aware the card was missing, sometimes in less than a minute. 

 
http://www.iol.co.za/index.php?set_id=1&click_id=13&art_id=vn20080912061731575C223003 

	
  

Italian cops clamp down on child porn 
June 20 2009 at 04:17PM 
 
ROME - Italian police arrested 14 people and placed more than 250 under investigation in the 
country's biggest sweep against Internet child pornography, authorities said in a statement. 

The 14 people who were arrested were in possession of cruel and violent videos that partly 
originated from a porn server based in Germany, the statement said. 

Authorities also conducted 300 searches and seizures in 68 towns and cities across the country in 
the operation codenamed Smasher. 

Police confiscated 800 computers and 40,000 items of data storage, including DVDs, CDs and 
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memory sticks containing more than 150,000 pornographic films, the statement said. - Sapa-AFP 

http://www.iol.co.za/index.php?set_id=1&click_id=3&art_id=nw20090620160543418C284067 

 
 
 

 
GROUP LEARNING ACTIVITY 2.5.1 

 
In groups, discuss what problems or cautions you feel users of ICTs should be aware of. Use 
the table below to list these problems or cautions. Then as a group rate these issues as either 
mild, serious or dangerous threats. 
 

 PROBLEM SCENARIO Mild  
Threat 

Serious 
Threat 

Dangerous 
Treat 

1     

2     

3     

4     

5     

6     

7     

8     

9     

10     
 
See the Feedback section later in this lesson to see how well you did. 
 
 
 



ICT Module, Workshop series 2010 
 

 

 

12 

SKILLS FOR A CHANGING WORLD Let your future take flight 

3. Conclusion 
ICTs are all around us, by now you should be able to identify them easily and also explain 
why a device could be categorised as ICT or not. Furthermore, you have a general idea about 
what benefits can be derived from using ICTs as well as what you need to be cautious of 
when working with ICTs. 
 

4. Feedback 

 
LEARNING ACTIVITY 2.2.1 

 
Below in bold are possible answers to the task of identifying input and output 
devices for various ICT devices. 
 

ICT Device Input component Processor Output component 

Cell Phone Keypad Microprocessor Speaker 

Bank ATM Keyboard, Surveillance 
Camera and card reader Microprocessor 

Money dispenser, ATM 
screen, Receipt 
dispenser, receipt 
printer 

Personal Computer (PC) 
Computer System 

Keyboard, mouse, 
digital camera or cam Central Processing Unit Monitor, speakers, 

printer 

Supermarket Checkout 
Scanner Scanner Microprocessor Till Price Display, Till 

slip printer, till receipt 

Car Satellite Navigation 
System Car positioning sensor Microprocessor Readout Screen 

 
 

 
GROUP LEARNING ACTIVITY 2.3.2 

 
There are in fact numerous issues that need to consider when using ICTs. These also vary 
with the device. Below are just a few suggestions. It is quite possible that your group found 
others. 
 

 PROBLEM SCENARIO Mild  
Threat 

Serious 
Threat 

Dangerous 
Treat 

1 
Identity theft – Criminals using your online identity to 
pose as yourself and embark on illegal activities using 
your name. 

   

2 Hackers – Programmers who attempt to break online 
security features to access data or financial accounts     



UNIT ONE: INTRODUCTION TO ICT 
 

 

 

13 

SKILLS FOR A CHANGING WORLD Let your future take flight 

3 Viruses – Malicious code designed to propagate itself 
and damage software and hardware     

4 
Spyware – Covert code designed to collect data about 
yourself and inform others about your habits and 
preferences  

   

5 
Ergonomics – Some people experience headaches, 
muscle strains or poor posture from spending too much 
time in front of computer screens 

   

6 
Time Wasters – Sites like FaceBook that are 
superficially engaging but take up a lot of time with little 
benefit  
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Identify examples of ICTs that exist in their 
environment   

List possible uses for specific examples of ICTs   

Transfer digital images from a cell phone/digital 
camera to a computer   

Identify benefits and problems regarding the use 
of ICT   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 
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Part 2: Using PowerPoint to 
Present 

1. Structuring Your Presentation 

 
 
http://www.propointgraphics.com/samples2.php?pop=&page=2&apage=1&isalbum=album-17&gal=3&ai=5&view= 

 
It does NOT have to be death by PowerPoint! With a bit of knowledge and a hint of 
creativity, you can create an impressive PowerPoint presentation, such as the one above. It is 
actually quite an exciting programme once you know how it works – you can insert graphics, 
sound, pictures, effects, etc. However, let’s start with the basics first. 
 

Outcomes 
Upon the completion of this Part, learners will be able to: 
 

• Demonstrate basic PowerPoint skills 
• Present information by means of a PowerPoint presentation 
• Insert media and graphics into a PowerPoint presentation 

 

Presentations 
A presentation involves you speaking to an individual or a group of other people in order to 
make point or share information. 
 
What is expected of you in terms of a presentation? 
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PowerPoint can be used to: 
• persuade 
• teach 
• sell 
• train 
• entertain 

 

The Basics 
 

 

Opening PowerPoint 
 
Click on: 
Start button>> Programs>> 
Microsoft Office>> PowerPoint 

 

A slide 
 
a single page within a 
presentation 
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A bullet 
 
a shape that appears in front of a 
sentence 
 

 

Layout 
 
the arrangement of text and 
objects 

 

Placeholder 
 
the place where you put content 
on a slide 

 

Sizing Handles 
 
a way of adjusting the size of your 
slide show 
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Slide Transition 
 
the visual transformation from 
slide to slide. 

 

Design Theme 
 
file that contains the styles in a 
presentation 
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GROUP LEARNING ACTIVITY 2.1  

 
Now it is time to experiment. In pairs, see if you can work out how to do the following. Use 
the space provided to write down the steps involved. Ask your facilitator for help if you really 
get stuck. 
 

1 Add a Slide 
2 Transform a list into bullet points 
3 Modify the layouts 
4 Add text to a placeholder 
5 Use sizing handles to rotate and move the a place holder 
6 Select a Slide Transition 
7 Apply a Design Theme to the Slide Show 
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2. Inserting Media and Graphics 
The following focuses on adding pictures, graphs, sound, videos, text and animation to your 
presentations. This is fun to do and will improve the quality of your presentation; it will also 
make it more interesting and enjoyable for those whom you are doing the presentation for. 
 
The term ‘multimedia’ refers to any combination of media that is delivered electronically 
and can be accessed interactively. 
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STEPS to inserting multimedia: 
 

 
 

Clipart 

Click Insert > Clip Art... 
 

* Use a keyword to search for the clip art you want. 
* Scroll down through the Clip Gallery to preview the clip art 

selection 
* Select the Clip Art and click it 
* The Clip Art will appear on your slide 
* When you are finished using the Clip Gallery, click the Close 

button in the Clip Gallery title bar 

 
 

Photographs 

Click Insert > Picture… 
 

* Find the folder where the picture is stored 
* Scroll down through the folder to preview the photographs 
* Select the file and click insert 
* The photograph will appear on your slide 

 
 

Sounds 

Click Insert > Click the arrow below the sound icon 
 

* Find the file on your computer 
* Select a pre-recorded sound in the clip organiser 
* Play a CD track 
* Record your own sound. 
* Decide whether you want the sound to start automatically or 

when clicked. 
* The sound icon will appear in the centre of your slide 

 
 

Motion Clip 

For animations … 
 
Click Insert > Click the arrow below the Movie Icon 
Select a pre recorded motion clip in the clip organiser (usually an 
animation) 

 
 

Motion Clip 

For Movies… 
 
Click Insert > the Movie Icon 
 

* Find the file on your computer  
* Decide whether you want the movie to start automatically or 

when clicked. 
* The motion clip will appear in the centre of your slide 
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GROUP LEARNING ACTIVITY 2.2.1  

 
In groups, try and duplicate the following PowerPoint slide. Use the space provided to make 
notes. 
 

 
 

NOTES: 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Demonstrate basic PowerPoint skills   

Present information by means of a PowerPoint 
presentation   

Insert media and graphics into a PowerPoint 
presentation   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 
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Part 3: The Basics of MS Word 

SECTION 1:  
FORMATTING TEXT & PARAGRAPHS 
Microsoft Office Word is used to create and share professional-looking documents. This 
user-friendly programme contains tools that make it easy for you to format your documents 
quickly in order for them to communicate to the reader more effectively. You can change 
the appearance of text, tables, and graphics throughout the entire document, as 
well as create your preferred style or colour scheme; this is what is referred to as 
formatting. 
 
In this Part of the module, you will be introduced to the basic tools you need to use MS 
Word effectively in your studies or in the workplace. 

1. Introduction 
Do not feel demotivated if you have had minimal experience with a computer; you will soon 
discover that they are surprisingly easy to use. This Section focuses on developing skills in 
terms of formatting text, paragraphs, as well as entire documents so that you can prepare 
documents that look professional and are impressive. Have a look at the learning outcomes 
below to see what formatting entails.  

LEARNING OUTCOMES 
On completion of this Section, learners will be able to 
 
Demonstrate basic MS Word skills in terms of: 

• Selecting texts using a variety of methods 
• Cutting, copying and pasting pieces of text 
• Using the undo/redo command effectively 
• Identifying and using all the commands in the Font and Paragraph group 
• Using styles effectively 
• Inserting page breaks and section breaks 
• Changing the layout of a page 
• Changing page margins 
• Inserting headers, footers and page numbers 26 
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2. Selecting Text 
In order to make changes to text, you must select it first. MS Word provides many ways to 
do this. 
 
To select lines, paragraphs or the entire document without scrolling, click the empty space in 
the left-hand margin of the text – this is called the Selection bar. When you are in the 
Selection bar, the pointer becomes a right-pointing arrow.  
 
Further methods of selecting text include: 
 

Action Selects 

Double-click the mouse on a word selects only the word 

Click in Selection bar beside a line selects the whole line 

Double-click in selection bar selects a whole block of text 

Click at beginning of a text block; hold down the 
<Shift>key and click at the end of text block selects a block of text 

Press Ctrl A selects ALL the text 
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3. Cut, Copy, Paste and Undo/Redo 
These are important functions to get to know, as they allow you to move items around in a 
document, get rid of them when necessary, or delete changes that you made to the 
document. You will make use of these often in MS Word. Study the image below of 
shortcut icons and refer to the table of functions. 

 
 
 

 
 
 
 

Shortcut icon Function 

 

CUT 
removes selected text 

 

PASTE 
replaces cut text 

 
COPY 
makes a copy of selected text 

 

FORMAT PAINTER 
copies formatting1 from one place and applies it to another 

 
UNDO 
deletes changes made 

 
REDO 
replaces deleted changes 

 

                                                      
1 Formatting refers to the layout or arrangement of text in a document. If you have cut text from one place in the 
document and pasted it in another, this is an example of formatting. The format painter will then copy what you 
did and apply it to the selected text in another part of the document. 
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LEARNING ACTIVITY 3.1 

 
Now you need to apply what you have learned so far. Duplicate the follow text and 
complete the instructions that follow. Once you have completed the activity, save the 
document in the location specified by your facilitator as follows (replace Name and Surname 
with your own name and surname): 
 
NameSurname_Part3_Activity_3.1 
 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
 
BBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBB 
BBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBB 
BBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBB 
BBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBBB 
 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
 
 
Instructions: 
 
1 CUT the second paragraph of text (Bs) and PASTE it below paragraph 3 (Cs). 
2 COPY the last line of Bs and PASTE it at the beginning of the Cs. 
3 CUT the last 4 As from paragraph 1 and PASTE them at the end of the last row of Cs. 
4 Now skip a line and create a new paragraph under the Cs of 4 rows of small ‘d’s. 
5 Use the Format Painter and copy the formatting of text in the Cs and apply it to the 

new paragraph of Ds. 
6 Save the updated document. 
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4. Font and Paragraph Commands 
Font and paragraph commands include: 

• Changing font style, size and colour 
• Making text bold, italicized or underlined. 
• Changing the alignment of text; and 
• Creating bulleted or numbered lists. 

 
You might not be familiar with some of the above-mentioned terms. The 
following are definitions and examples to help you understand what they are: 
 
1. Fonts refer to different types of writing styles: 

• Garamond font 

• Rockwell font 

• Comic sans font 
 
2. Alignment refers to the position of text on a page: 

 
“Align text left” looks like this: 

 
 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAA 
AAAAAAAAAAAAAAAAAAAAAAAAAA 
 
“Align text right” looks like this: 

 
BBBBBBBBBBBBBBBBB 

BBBBBBBBBBBBBBBBBBBBBBBBB 
BBBBBBBBB 

 
“Centred” text looks like this: 

 
 

CCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
CCCCCCCCCCCCCCCCCCCC 

CCCCCCCCCCCCCCCCCCCCCCC 
 
“Justified” text creates a neat block of text like this: 

 
 
DDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDD 
DDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDD 
DDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDD 
DDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDD 
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3. Bulleted and numbered lists refer to a list of text that either has bullets at the 
beginning of each point, or numbers at the beginning of each point. 
Look at the following examples: 

 
Bulleted text: 
• AAAAAAAAAAA 
• BBBBBBBBBBBBB 
• CCCCCCCCCCCCCCC 
• DDDDDDDD 
 
Numbered text: 
1. AAAAAAAAAAA 
2. BBBBBBBBBBBBB 
3. CCCCCCCCCCCCCCC 
4. DDDDDDDD 

 
Look at some of the other options available to us from the Font and Paragraph groups of 
commands. 
 

 
 
 
TASK: Now, experiment a little with a partner and complete the table on the following 
page. 
 

 Name  What does it do? 

1 

 
  

2 

 

  

3 

 

  

4 

 
  

5 
 

  

6 
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7 

 

  

8 
 

  

9 
   

10 

 
  

11 

 
  

12 
 

  

13 

 

  

14 
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5. Working with Styles 
When you use a computer, you want to be as efficient as possible. You want to be able to 
create and format documents with minimal effort, yet give them a professional appearance. 
The following table provides information on formatting and styles. 
 

MS Word Styles 
 

 
 
Note: the default (automatic) settings for a new document 
are usually as follows: 12 point Times New Roman, English, 
single spacing, Left alignment, and widow/orphan control. 

Location – Home tab (Styles) 

A style is a set of formatting characteristics 
that you can apply to text, tables, and lists 
in your document to quickly change their 
appearance. 
 
How to: 
To apply an existing MS Word Style, all you 
need to do is place your cursor anywhere 
in the piece of text and select a style. The 
style will be applied to any piece of text 
separated by a hard return (Enter). 

 

Paragraph Style 
 

 
 

Location – Home tab (Styles) 

A paragraph style controls all aspects of a 
paragraph's appearance, such as text 
alignment, tab stops, line spacing, and 
borders, and it can include character 
formatting. 

 
How to: 
1 Open the Styles window. 
2 Click on the icon for “New Style” at 

the bottom of the window. 
3 Give the style a name. 
4 Make sure the “Style type” is 

Paragraph, and make sure the Based 
on option is Normal. 

5 Select a font style; font size and font 
colour. 

6 Select whether you want to make it 
Bold, italics or underlined. 

7 Select a paragraph alignment. 
8 Select line spacing. 
9 Select option to indent text if 

suitable. 
10 Adjust spacing before and after the 

paragraph. 
11 Click “OK” when done. 

Character Style Location – Home tab (Styles) 

A character style affects selected text 
within a paragraph, such as the font and 
size of text, and bold and italic formats. 
 
How to: 
Unlike a paragraph style that can format 
font, border, language, line spacing, 
alignment and indents, a character style 
can format only fonts, borders and 



PART THREE: THE BASICS OF MS WORD 
 

 

 

11 

SKILLS FOR A CHANGING WORLD Let your future take flight 

 

languages. To create a character style 
make sure the Style type selected is 
Character and the Based on option is 
Default Paragraph Font. You might use this 
tool if you wanted quotations to stand out, 
for example. 

Inserting Section Breaks and Page 
Breaks 
 

Select  to see Section Breaks 
 

 
 
 
 
 

Location – Page Layout tab (Page Setup) 

To apply different formats throughout the 
document, you need to add section 
breaks, which are markers that divide the 
document into sections enabling you to 
format each section separately. 
In other instances you may want to use the 
same formatting, but start text on a new 
page instead of waiting for MS Word to 
start a new page for you, in which case 
you will use a page break. 
 
How to: 
1 Click on place on the page where you 

want to insert a page break or section 
break 

2 Click on Page Layout 
3 Click on the arrow next to Breaks 
4 Click on Page to insert a page break 
5 Click on Next Page to insert section 
6 break 
7 6. Remember to add another section 

break should you want to return to the 
original formatting 



ICT Module, Workshop series 2010 
 

 

 

12 

SKILLS FOR A CHANGING WORLD Let your future take flight 

Changing Page Orientation 
 

 

Location – Page Layout tab (Page Setup) 

Landscape orientation – Page is 
displayed horizontally, long sides of the 
paper are at the top and the bottom. 
Portrait orientation – Page is displayed 
vertically, short sides of the paper are at 
the top and the bottom. 
 
How to: 
1 Click on Page Layout 
2 Select Orientation 
3 Choose either Landscape or Portrait 

Changing Page Margins 

 
At top and left-hand side of page 
 

 

Location – Top and left-hand side of page OR 
Page Layout tab (Page Setup) 

Generally, all text and images are included 
between the margins. 
 
How to: 
1 Click on Page Layout 
2 Click on the small arrow under Margins 
3 3. Select an option or click on Custom 

Margins to set your own margins 

Inserting Headers, Footers and Page 
Numbers 
 

 
 

 

Location – Insert tab (Header & Footer) 

A header or footer contains text or 
graphics that are printed at the top or 
bottom of every page in a document. A 
header is printed in the top margin – footer 
is printed in the bottom margin. Common 
items placed in headers/footers are Title of 
Document, Student Number, Page 
Numbers and Date. 

 
How to insert a Header and Footer: 
1 Click on Insert 
2 Click on the small arrow under Header 

or Footer 
3 Select the layout option you prefer 
4 Type in the text that you want to have 

appear as either a Header or Footer 
 
How to insert Page Numbers: 
1 Click on Insert 
2 Click on the small arrow under Page 

Numbers 
3 Select the layout option you prefer 
4 You can click on Format Page 

Numbering if you want your page 
numbers to start at a specific number 

Inserting a Drop-Cap 
 

Location – Insert tab (Text) 

Drop caps, or large initial letters or words 
at the start of a paragraph or document, 
can add style and focus to your 
documents, for example:  
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 Drop cap 

You can use them in letters to add your 
own special touch. Or you can use them at 
the start of sections of a newsletter or 
report to help your readers' eyes find their 
way through the page. 
 
How to: 
1 Click the paragraph that you want to 

begin with a drop cap. 
2 Click on Insert and click Drop Cap. 
3 Click Dropped. 
4 Click OK. 

 
 

Information and “How to” table 
 

 
LEARNING ACTIVITY 3.2 

 
Duplicate the follow text and complete the instructions that follow. Once you have 
completed the activity, save the document in the location specified by your facilitator as 
follows (replace Name and Surname with your own name and surname): 
 
NameSurname_Part3_Activity_3.2 
 

 
 
To duplicate the above text, follow the following specifications: 
 

Use font (Arial 13); select  button; leave 1 space between each paragraph 
 
Page 1: 
Paragraph 1: 4 lines of capital As  
Paragraph 2: 6 lines of small ‘b’s  
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Paragraph 3: 8 lines of capital Cs 
Paragraph 4: 10 lines of small ‘d’s  
Paragraph 5: 13 lines of capital Es  
Paragraph 6:  8 lines of small ‘f’s  
 
Page 2:  
leave 1 space at page top 
Paragraph 7: 8 lines of capital Gs 
Paragraph 8: 33 lines of capital Hs 
 
Page 3: 
Paragraph 9:  18 lines of capital Is 
Paragraph 10:  26 lines of capital Js 
 
 
NOTE:  
To create capital letters, press the Caps Lock key on your keyboard that looks like this: 

 
 
When you want to take it off, press it once again. 
 
 
 
Now, you need to apply your newly acquired skills and do the following: 
 
1 Select the first A in paragraph 1 and insert a ‘dropped’ Drop Cap 

 
2 Select paragraph 3 and 4 (page 1) and change the Style formatting as follows: 

a Font: Jokerman, 12 point, bold, italics, colour-blue 
b Paragraph Style 

• Alignment: Justify 
• Indentation: Left: 1.27 cm 
• Line Spacing: 1.5 
• Paragraph Spacing – Before: 12 pt; After: 12 pt 

 
3 Select paragraph 5 (page 1) and change the Style formatting as follows: 

a Font: Lucida Sans Typewriter, 24 point, colour-orange 
b Character Style 

• Alignment: Centre 
• Line Spacing: single 

 
4 Insert a Section Break at the end of paragraph 5 (Es) and at the end of paragraph 7 

(Hs) 
 
5 Change the Page Orientation of the page with paragraph 6 and 7 to Landscape 
 
6 Select paragraphs 8 and 9 and change the Page Margins as follows: 

a Top: 1 cm 
b Bottom: 2 cm 
c Left: 2.5 cm 
d Right: 2.5 cm 

 
7 Insert Page Numbers and a Header with your name, surname and date 
 
 
Remember to save your document as NameSurname_Part3_Activity_4.1. Save the 
document as soon as you have opened it and do so regularly so that you do not lose any 
information. 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Select text using a variety of methods   

Cut, copy and paste pieces of text   

Use the undo/redo command effectively   

Identify and use all the commands in the Font 
and Paragraph group   

Use styles effectively   

Insert page breaks and section breaks   

Change the layout of the page   

Change page margins   

Insert headers, footers and page numbers   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 

 

 

 

 





Part 3: The Basics of MS Word 

SECTION 3: TABLES 

1. Introduction 
A table is a grid of cells consisting of rows and columns. Tables can be customized and are 
useful for a variety of tasks, from presenting numerical data to creating unique text layouts. 
 
Tables can be any size and they can easily be modified. You can create a table with just one 
cell, with two cells, even with 100 cells or more. Table cells, rows, and columns can be 
added, deleted, split, and merged (joined) at any time. Once a table has been created, you 
can insert anything into a cell that you could in a normal document (e.g., text, images, or 
even another table) and then format it with any of Word's tools. 
 

  Column   

 Cell Cell Cell Cell 

 Cell Cell Cell Cell 

Row Cell Cell Cell Cell 

 Cell Cell Cell Cell 

 Cell Cell Cell Cell 
 

Learning outcomes 
On completion of this lesson you will be able to... 

• Insert, create or draw a table 
• Add information to a table 
• Add a new row or column to a table 
• Delete a row or column from a table 
• Merge and split cells 
• Increasing and decreasing row or column size 
• Format text within the cells 
• Repeat headings in a table 
• Add borders and shading 
• Use table styles 
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2. Creating Tables and Adding Information 

Information and “How to” table 
 

Creating tables 

 

Location – Insert tab (Tables) 

When creating a table, it helps to try and 
spend a little time first planning how you 
would like your table to look. Even a 
simple paper sketch can reduce the 
amount of time needed later to make 
the table look exactly right. Once you 
know what you want the finished table 
to look like, you can use one of four 
ways to create it: 
 
How to: 
1 Drag to select the number of rows 

and columns that you want. 
2 Click Insert Table and choose the 

table dimensions and format before 
you insert the table into a 
document. 

3 Click the Draw Table option and 
draw a complex table — for 
example, one that contains cells of 
different heights or a varying 
number of columns per row. 

4 Click Quick Tables and choose an 
option from a gallery of existing 
preformatted tables. 

Adding Information 

 

How to: 
Adding information to a table is simple. 
Just click inside a cell and type. You can 
add anything inside a table that you 
could outside the table. If you want to 
add information in separate cells, you 
will need to move your cursor from cell 
to cell in the table. You can do this by: 

• Pressing [Tab] 
• Pressing an arrow key. 
• Using the mouse and clicking in the 

appropriate cell 

Formatting tables 
 

When you click on any table you have 
created, you will notice a new set of tabs 
that appear under Table Tools in the 
Ribbon: 
 
1. Design Ribbon 
2. Layout Ribbon 
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Design Ribbon 
 

 

Location – Design tab  
The design ribbon offers a wide range of 
formatting flexibility. You can use any 
one of the predefined Table Styles listed 
on the Ribbon or you can create 
something that meets your exact needs. 
The best part is that Word 2007 allows 
you the ability to first preview these 
templates and themes before you 
commit to them. 
 
It is also here on the Design Ribbon 
where you can set the type of line you 
would like to use, the width of that line, 
and the color. You can also set shading 
and place or remove border lines. These 
format settings can be applied to a 
specific cell, row, column, or to the 
entire table. 
 
How to: 
1 Select your table and then click on 

Design 
2 Run your cursor over the Table 

Styles in the box. You will notice 
that Word gives you a preview of 
what your table with look like. 

3 Select the arrow on the right hand 
side of the Design Ribbon to view 
more Style options 

4 Click on the Style you like most 
5 You can select the Shading option 

on the right of the Design Ribbon if 
you want to colour the table in a 
specific colour 

6 The Borders option on the right of 
the Design Ribbon allows you to 
place or remove border lines. 

 

Layout Ribbon 
 

Location – Layout tab  

This Ribbon allows you to: 
1 insert rows and columns into your 

table; 
2 split cells into further rows and 

columns or merge or join several 
cells together to form one; 

3 size individual cells, rows, columns, 
and the entire table 

4 align the table and text within the 
table 

5 change text direction and cell 
margins 

 
How to: 
1 To insert rows and columns, look at 

the Rows & Columns section and 
select either Insert Above or Insert 
Below to add a row; or Insert Left or 
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Insert Right to add a column. 
2 You can Merge, Split Cells or Split 

Table by selecting the Merge option 
on the Layout Ribbon 

3 The Cell Size section allows you to 
align the table on the page and also 
make adjustment to the size of cells 
and the table as a whole 

4 The Alignment section allows you to 
align the whole table (right, centre 
or left), as well as the text in the 
cells. 

5 5. The Alignment section also 
allows you to change the direction 
of text within your table, as well 

 
 
 

 
LEARNING ACTIVITY 3.4 

 
Duplicate the following table in a new document and then follow the instructions. 
 
To duplicate the table below: 
 

1 Insert a table with 3 columns and 4 rows 
2 Select Table Style “Light Grid – Accent 2” 
3 Insert the text as seen below into the cells 
4 Centre the text in the cells 
5 Set the Cell Margins to Left: 0.6 cm and Right: 0.6 cm 
6 Autofit Contents 
7 Merge the cells of the last row 

 

Monday Tuesday Wednesday 

Swimming Extra English classes Hockey 

Rugby Learn for History test Visit Granny 

 
Now, do the following: 
 

1 Insert two columns to the right of Wednesday 
2 Label the columns Thursday and Friday and Centre the Text 
3 Autofit Contents 
4 Insert another row below row 4 
5 Split the first 3 cells of the new row (row 5) into 3 columns and 1 row 
6 Delete row 4 
7 Shade the entire table Red, Accent 2, Lighter 60% 
8 Save your document as NameSurname_Part3_Section3_Activity_2.1 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Insert, create or draw a table   

Add information to a table   

Add a new row or column to a table   

Delete a row or column from a table   

Merge and split cells   

Increasing and decreasing row or column size   

Format text within the cells   

Add borders and shading   

Use table styles   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 
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Part 4: MS Excel Spreadsheets 

1. Introduction 
Spreadsheet programs are used in the workplace to arrange data, make calculations, create 
graphs and charts and more. The following table gives a few examples of who and why 
people use spreadsheets: 
 

Accountants  to keep track of the money coming into and out of the business. 

Sports Broadcaster  to note, comment and present important sports statistics to their audience 
in a match 

Civil Engineers  to assist with the calculations required to construct roads, bridges and 
buildings 

Advertising executives to collect, compile and analyse answers to market research questions 

Teachers to record and calculate students attendance and results over a semester 
or a year 

Sales People to determine the volume and profit of items sold 

 
According to Microsoft, more than 40 million people worldwide now use Excel. 
This makes it the most popular spreadsheet of all time. 
 
You can use Excel for the following (just to mention a few): 

• To keep to a budget 
• To process and manipulate data for your studies 
• To provide sorted lists of results for your sports committee 
• If you want to keep track of your marks 

 

Learning outcomes 
After completing this Part, learners will be able to demonstrate their understanding of Excel 
in terms of: 

• Renaming, inserting and deleting a worksheet 
• Inserting, deleting columns and rows and navigating cells 
• Using Fill Handles, AutoFill, AutoComplete and inserting formulas 
• Formatting Cells 
• Saving Excel workbooks 
• Create graphs and charts in MS Excel 
• Format and label charts and graphs 
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2. Terminology 
In order to learn to operate Excel, you should familiarise yourself with the following 
terminology. 
 

Spreadsheets 
 

 

A spreadsheet is a large grid of cells 
arranged in rows and columns. Data (text, 
numbers and formula) are then entered 
into the cells and restructured for a person 
to examine. 
 
Excel is the digital version of an 
accountant's worksheet. This application 
does much more than offering 
accountants neat rows and columns. It 
helps makes the repetitive tasks quicker 
and easier. 
It can automatically do most of the 
calculating (and recalculating) for you. And 
it can allow you create a variety of charts 
and graphs to visually represent your data. 

Workbook 
 

 

A complete Excel file is referred to as a 
Workbook. 

Work sheets 
 

 
 
 
 
 
 
 

A Worksheet is a separate page within a 
Workbook. A Workbook could contain a 
number of separate Worksheets. To view a 
worksheet, take a look at the sheet tab at 
the bottom left of the workbook window. 
When you click each sheet, you’ll be able 
to view another worksheet. You can 
rename these sheets and create additional 
sheets 



PART FOUR: MS EXCEL SPREADSHEETS 
 

 

 

5 

SKILLS FOR A CHANGING WORLD Let your future take flight 

The Ribbon 
 

 
 

At the top of the page is a feature called 
the Ribbon. The Ribbon consists of a 
number of tabs. Each tab contains specific 
commands. 
 
The Ribbon is a new feature in Excel 2007. 
It replaces the toolbar. 

Columns 

 
 

Much like pillars or posts, columns are the 
vertical cells. Letters, called Column 
Headers, identify these cells. 

Rows 

 
 

Rows are the cells that go from left to 
right horizontally on the worksheet. 
Numbers, called Rows Headers, identify 
these cells. 

Cells 

 

Each small box within the grid on your 
page is known as a cell. Cells are identified 
by their column and row. E.g. cell C2 is in 
Column C and Row 2 

Active cells 
 

 
 
 
 

The cell that has a heavy outline is known 
as the active cell. It is highlighted in black, 
to indicate that any data you enter will go 
in that cell. You can make a cell active by 
clicking on it, pressing tab, enter or the 
arrow keys. You will notice that the 
Columns and Rows of the active cell are 
highlighted. 

Fill Handles 

 
 

The small squares that appear at the 
corners of the active cell are known as the 
fill handles 
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Name box 
 

 

Just below the ribbon, on the left of the 
page is the Name Box. The Name Box is 
used to show the cell reference of the 
active cell. 
 
In this example, the cell is in Column H 
and Row 10. 

Formula bar 
 

 
 

The formula bar is above the grid and to 
the right of the Name box. 
The formula bar displays the data or 
formula stored in the active cell. 
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3. Working with Excel 
In this section you will see how to use Excel. Read through the table below to familiarise 
yourself with the various things can do using Excel. You will return to these steps as you 
work through activities 3.1 and 3.2. If you are working at a computer, it would be a good 
idea to try out some of these processes while you read them. 
 

Creating a new workbook  
 

 

 

To create a new workbook: 
 

1 click on the Office button 
on the top left 

2 select New 
3 click on Blank Workbook 
4 a new workbook (with a 

different name) will open 

Inserting a worksheet into a workbook 
 

 

To insert a new worksheet: 
 
1. click the worksheet button on the 
right hand side of the sheet tabs 
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Renaming a worksheet 
 

 

To rename a worksheet: 

 
1 Right-click the sheet tab of the 

sheet you want to rename 
2 select rename 
3 type in the name you want to 

give the worksheet 

Deleting a worksheet 
 

 

To delete a worksheet: 

1 Look at the Ribbon 
2 Click the Home tab 
3 in the Cells group, click the 

arrow on Delete 
4 Delete Sheet 

Inserting and deleting columns 
 

 
 

 
 
 

To insert a column: 

1 click a cell immediately to the 
right of where you want to 
insert a new column. 

2 click on the Home tab on the 
3 Ribbon 
4 click on the Cells group; click 

the arrow on Insert 
5 click Insert Sheet Columns 

 
To delete a column: 

1 click a cell in the column 
2 click on the Home tab 
3 in the Cells group, click the 

arrow on Delete 
4 Click Delete Sheet Columns 
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Inserting and deleting rows 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To insert a row: 

1 click a cell in the row 
immediately below where you 
want the new row 

2 click on the Home tab; in the 
Cells group, click the arrow on 
Insert 

3 click Insert Sheet Rows 
 
To delete a row: 

1 click a cell in the row 
2 click on the Home tab; in the 

Cells group, click the arrow on 
Delete. 

3 click Delete Sheet Rows 
 
Alternately you could use the right 
click function with your mouse. 
 

1 select the row immediately 
below where you want to 
insert a new row Right-click 
your mouse and select insert 

2 tick the box for the function 
you wish to perform 
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Formatting a cell 
 

 
 
 
 
 
 
 
 

There are a wide variety of 
formatting options: 
 

1 Right click a cell and select 
Format to see number, 
alignment, font, border fill and 
protection options. 

2 To format a cell for currency, 
select the cell and right click. 
Click on the number tab, 
choose 2 decimals and select a 
country symbol. If you selected 
South Africa, your cell will 
then have an R symbol before 
it. If you selected USA, your 
cell will have a $ before it. 
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Saving your work 
 

 
 
 
 
 
 
 
 
 
 

It is important to remember to save 
your work often. 
 
To save: 

1 click the Save icon (next to the 
office button) on the top left 
hand side of the screen 

2 the first time you save a 
workbook, you will need to 
give it a name 

3 if you want to change the 
name later, or if you want to 
keep the old version in the old 
name and create a new 
version with a new name, click 
the office button and use the 
Save As option 

4 this will create a duplicate file 
and save it under a new name 

5 5. your old file with the old 
name will still be there, and 
you will now be working in the 
new file with the new name 
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Using AutoFill 
 

 

You can use the AutoFill feature to 
enter the months of the year, days 
of the week, consecutive dates, or a 
series of numbers. 
 

1 type one or more of the above 
entries 

2 2. click on the small square 
(bottom right of the active 
cell); left-click your mouse and 
drag it across as many cells as 
you want “Autofilled” 

Using AutoComplete 

 
 

You can use the AutoComplete 
feature to fill in the remaining 
characters for you. If the first few 
characters you type in a cell match 
an entry you've already made in the 
same column, Excel will complete 
the word automatically. Just press 
ENTER. 

Navigating cells 
 

 

 
 
 
 

How to select cells: 

A single cell: 
click on the cell 
 
 
A range of cells next to each 
other: 
drag from the first cell you want to 
select to the last 
 
 
Non adjacent cells or ranges: 
hold CTRL (Windows) and click or 
drag an entire row or column OR 
click on the row or column heading 
 
 
All cells: 
click on the upper left corner 
 
 
The next cell to the right : 
use the Tab key or the arrow keys 
 
 
The next cell down the column: 
use the Enter key 
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Using Formulas 
	
  

	
  
	
  
Click on C8 and type the following in the formula bar: =(C7-
B7), then press Enter 
 
Click on D3 and type the following in the formula bar: 
=(C3*12), then press Enter 
 

Excel allows you to apply a variety of 
formulas to your data; worksheets 
are automatically recalculated based 
on the mathematical formulas and 
functions that connect your 
information. 
 
How to: 

To add up the entertainment 
expenses for February: 

1 Click on cell C7 
2 type “=SUM(C3:C5)” which 

will add up cells C3, C4 and 
C5 

3 OR “=(C3+C4+C5)” 
4 press Enter 
5 you should get the answer 

1280 
6 Look at the table on the left 

for other Maths operators you 
can use to subtract, multiply 
and divide. 

7 You can add, subtract, 
multiply or divide cells 
however you like by applying 
formulas. 

 
Examples: 

Subtract the total January expenses 
from the total February expenses 
Multiply the DSTV expense of 500 by 
12 to determine the annual expense: 

Working with Functions 
 

Instead of entering lengthy formulas 
such 
as“=C2+C3+C4+C5+C6+C7+C8+C9
+ C10” you could use the function 
SUM(C2:C10), which would save 
you a lot of time. 
Have a look at the table on the left 
for time-saving functions you could 
use. 
 
Useful shortcuts: 
 

 
 
1. Highlight the values 
You could highlight the values that 
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you want to calculate the total of 
and click on the AutoSum icon. Excel 
will assume that you wish to 
calculate the total of the highlighted 
cells. 
 
2. Enter Equals 
When you type “=” and the first 
letter into the function bar, Excel 
assumes that you want to use a 
function and provides a list of 
common functions. 
 
3. AutoAverage 
Click a cell below the numbers for 
which you want to find the average 
and then click the arrow next to 
AutoSum, on Average, and press 
ENTER. 

 
 

 
PRACTICAL LEARNING ACTIVITY 3.1 

 
Now you need to apply what you have learned so far. Follow the instructions below and 
make a note in the space provided of the steps taken to complete the activity. The image 
below is what your spreadsheet should look like at THE END; follow the instructions 
carefully. 

 

INSTRUCTIONS: 
1 Create a new workbook and name it: 

NameSurname_Part4_Section1_Activity_3.1 



PART FOUR: MS EXCEL SPREADSHEETS 
 

 

 

15 

SKILLS FOR A CHANGING WORLD Let your future take flight 

2 Delete worksheet 3 so that you only have 2 worksheets 
3 Rename your worksheets Grocery List and Monthly Expenses 
4 Type the heading Product Name in column A; January in column B and Projected 

annual expense in column C 
5 Directly under Product Name, type in Cheese, Chicken, Fruit, Vegetables, Handy 

Andy, Bread, Cold meats, Toilet paper and Total 
6 Format column C (January) as follows: Currency, Symbol R, 2 decimal places 
7 Directly under January, type in 25; 45; 20; 20; 16.5; 9.5; 24; and 36  
8 Insert a row between Product Name and Cheese and another row between Toilet 

paper and Total 
9 Bold Row 12 
10 Calculate the total expenses for January using a formula 
11 Insert a column to the left of Product Name and type in corresponding numbers for 

the grocery products from 1 to 8; double-click on the column heading to auto-size 
it. 

12 Select ALL cells and Left-align them 
13 Insert a column to the right of January 
14 Use the AutoFill function to give the new column a heading 
15 Select Cells D3 through to D10 and use the AutoFill function to allocate the same 

expenses for this new column 
16 Use the AutoFill function to determine the total expenses for the new column 
17 Select Cell E12 and calculate the projected annual expense for groceries using a 

formula 
18 Save your document 

 
 

 
GROUP LEARNING ACTIVITY 3.2 

 
Work together with a partner to complete the following quiz to see how much you 
understand about Formula and functions with this ten question multiple choice quiz. 

 

 
 

1 If you enter the formula = 5*3+4*5 into a 
cell and press enter, the cell will display the 
following value: 

a 17 
b 35 
c 1 
d The formula will not work 

2 Which formula would you enter into F2 to 
find Bhengu’s average: 

a 58+55+56/3= 
b =(B2:D2)/3 
c =(58+55+56)3 
d =AVERAGE(B2:D2) 

3 If you have the formula =B2+C2+D2 in cell 
F2 and you copy that formula to cell F3 what 
will the result be: 

a 169 
b 182 
c 204 
d None of the above 

4 A quickest way to add up Bhengu’s total is 
to click on E2 and: 

a Click the data tab on the ribbon menu and 
click the subtotal button 

b Enter = and the answer will appear in the 
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formula bar 
c Click the AutoSum button on the home 

menu 
d Highlight the cell and click F11 

5 Chetty’s total results were 182. If you looked 
in the formula bar, what would the formula 
that added up the three assignments look 
like? 

a =SUM(B3:D3) 
b =ADD(B3:D3) 
c B2+C2+D2 = 
d =AUTOSUM(B3:D3) 

6 If you wanted to quickly apply the formula 
used in E2 to E3 and E4, you would… 

a Copy the cell with the formula, and then 
place the insertion point in the cell you want 
to copy it to and press enter and then repeat 
until all the cells had the formula 

b Click the data tab on the ribbon menu and 
click the Auto copy and paste formula 
button 

c Click on the cell, click on the fill handle at 
the bottom left and drag it over the selected 
cells 

d Drag the Paste button on the Standard 
Toolbar across the cells and then click in the 
formula bar. 

7 What function would be the best to use to 
calculate Bhengu, Chetty and Harvey’s 
average total: 

a RAND 
b AVERAGE 
c MAX 
d COUNT 

8 Look at the marksheet above. What is the 
correct formula to automatically determine 
the average marks in cells E1 to E3? Please 
select an answer... 

a =AVERAGE(E2,E3,E4) 
b =AVERAGE(E2:E4) 
c =SUM(E2:E4)/COUNT(E2:E4) 
d All are correct 

Feedback 1 
 
 
 
 
 
 
 
 
 

                                                      
1 1b, 2b, 3b, 4c, 5c, 6c, 7b, 8d 
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Working with Graphs and Charts 
 
Excel’s chart and graphing capacities are a good place to start when using graphs to explain 
complex information. 
 
Graphs and charts allow us to visualise data and communicate information clearly and efficiently. 
Viewers of a chart or graph can quickly make comparisons, identify patterns and spot trends.  
 
Sometimes the complex combinations of text and numbers in spreadsheets can be confusing. 
Graphs and charts attempt to assist people to view, compare and analyse data. They display the 
relationship between numbers and amounts visually. 

Types of Graphs 
 

Bar Graphs 

 
 

Pie Charts 

 

If you need to compare values side by side, 
then bar graphs are most useful for showing 
the contrast in item numbers. A bar graph 
consists of a vertical and horizontal axis and 
bars can run horizontally or vertically. These 
bars are used to show different values. 
 
The bar graph on the left shows the sale of 
items on a day-to-day basis, for one week. 
The blue bar (on the left) represents how 
much Coke was sold on each day; red (the 
middle bar) reflects the sale of chips and the 
green bar (on the right) shows how many Bar 
Ones were sold. 
 
If you need to show the size of the parts that 
make up a whole, then pie charts are useful 
for showing the contrasting proportions. The 
larger the slice in the pie, the greater 
percentage of the information. They are 
useful when you want to emphasize a 
significant element. 
 
The chart alongside represents the proportion 
of items sold as a slice of the pie. Almost half 
of items sold were Cokes and the least 
popular item was the Bar One. 

Line Graphs 
 

 

A line graph is useful for showing a pattern 
over time. Such a graph is usually used to 
display the relationships between two pieces 
of information and how they vary. 
 
The line graph on the left shows which day 
was the post profitable day in the week. The 
net profit runs on the X axis (vertically), while 
the days of the week run along the Y axis 
(horizontally). 

Creating a graph 
 

To create a chart in Excel, you enter the data 
for the chart on a worksheet. The data can be 
arranged in rows or columns, Excel 
automatically determines the best way to plot 
the data in the chart. 
 
Steps: 
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1. Highlight the data you would like reflected 
in the chart 
2. Click INSERT and SELECT your chart type 
3. The chart will appear below the table in 
the Excel spreadsheet 
 
Now you can modify the look of your chart as 
well as the data that is displayed in it. 
Select your chart and you will see three new 
ribbons in the menu bar (Design, Layout 
and Format). These ribbons allow you to 
customize all aspects of your chart. 
 
Follow the steps on the following page to see 
how to customise your graph. 

Design Ribbon 

 
 
Layout Ribbon 

 
 
Layout Ribbon 

 
 
 
 
 
 

If you click on the Design tab, you’ll be able 
to make changes to the basic options 
regarding the chart (change the type of chart, 
change the data that you want displayed in 
the chart, change the layout of the chart, 
what kind of chart is it, etc.).  
 
If you click on the layout tab, then you will 
be able to add/edit/delete chart items like the 
title, legend, and so on.  
 
Format allows you to change the appearance 
of the chart. 
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PRACTICAL LEARNING ACTIVITY 3.3 

 
1 Use the grocery list from activity 3.1 to generate 2 types of graph (e.g. a pie and bar 

chart). 
2 You must also specify which type of graph you think works best to represent the 

information and why. 
3 Furthermore, play around with the Design, Layout and Format ribbons to generate 

original, colourful graphs. 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Renaming, inserting and deleting a worksheet   

Inserting, deleting columns and rows and 
navigating cells   

Using Fill Handles, AutoFill, AutoComplete and 
inserting formulas   

Formatting Cells   

Saving Excel workbooks   

Create graphs and charts in MS Excel   

Format and label charts and graphs   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 
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How will you do this? 
 

 

 

 

 
 



  

 

Part 5: 
Communication 
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Part 5: Communication 

SECTION 1: E-MAILING 

1. Introduction 
In this Part, we will focus on how to use the computer to improve communication. In the 
world of work, or as tertiary education students, it will be essential that you can use the 
latest communication technologies. 
 
E-mail is electronic mail, which has been an unprecedented success. Businesses have seen 
the advantages offered as being very important to improving their productivity and 
profitability.  
 
There are many advantages to using e-mail. E-mail provides a way to exchange information 
between two or more people with no set-up costs and it is generally far less expensive than 
physical meetings or phone calls. Much of the business world relies upon communications 
between people who are not physically in the same building, area or even country; setting 
up and attending an in-person meeting, telephone call, or conference call would not only be 
inconvenient, but also time-consuming and costly. E-mail allows asynchrony, which allows 
the recipient to review and respond to the mail at a time that is convenient. The e-mail 
recipient is able to decide when and how much time they will spend dealing with any 
associated information.  
 
There are also a number of disadvantages associated with the use of e-mail as a 
communication tool. Most business workers today spend from one to two hours of their 
working day on email: reading, ordering, sorting,„re-contextualising‟ fragmented 
information, as well as writing and replying to emails. The use of email is increasing due to 
increasing levels of globalization, labour division and outsourcing, amongst other things. 
Email can lead to some well-known problems such as loss of context, where the context is 
lost forever; information overload, where the use of mailing lists and „copy all‟ can lead to 
people receiving unwanted or irrelevant information that is of no use to them. 

Learning Outcomes  
On completion of this Part, you will:  

• Understand the relationship between the Internet, email and communication  
• Be aware of the advantages and disadvantages of email communication  
• Be able to setup and use a webmail account  

 

2. Communicating via the Internet  
The Internet is a communication system that allows computers around the world to 
communicate and to exchange information with each other. The Internet also facilitates 
access to resources, such as files, services, or other people.  
 
A group of computers that have been joined together or connected is known as a network.  
Computers in a network can communicate with one another. 
 
Many schools, universities, businesses, and government institutions around the world have 
networks. All of these networks are connected to one another in a huge worldwide 
network, which is called the Internet.  
 
Networked computers communicate through telephone lines, cables, wireless, and satellite 
links. Being connected is not enough, though computers must also understand one another. 
Just like people, they must speak the same language in order to communicate. Computers 
connected to the Internet exchange instructions that allow them to ‘talk’ to one another. 
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Computers break information into small chunks, called packets. Each packet travels along 
the Internet on its own. When the packets reach their destination, they’re put back together. 
Sometimes, a packet gets lost, but even before you now it’s missing, it’s sent again and joins 
the other packets. 
 
Packets do not travel directly from one computer to another on the Internet. They travel 
through machines called routers. A router is like a traffic cop at a busy intersection. It reads 
the “address” on each packet and decides what path the packets should travel. Packets sent 
to far off computers may go through many routers. 
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3. Setting up a webmail account 

Setting up a webmail account 

 

There are hundreds of services to 
choose from where you can create 
a webmail account, but 3 popular 
services:  
 
· Google Mail: 
http://www.gmail.com  
 
· Yahoo Mail: 
http://www.ymail.com  
 
· MS Hotmail: 
http://www.hotmail.com  
 
Steps:  
 
1. Type in: http://www.gmail.com  
 
2. Click on “Create an account”  
 
3. Fill in all the information asked 
of you under “Get started with 
Gmail”  
 
4. Click on “I accept. Create my 
account.”  
 
5. Congratulations! You‟ve 
successfully signed up for Gmail!  
 
6. Click on “Show me my account” 
to start sending e-mails.  
 
7. Click on “Compose Mail” to 
send someone and e-mail  
 
 

Netiquette  
 
Examples of emoticons1:  

Netiquette refers to the 
conventions of good behaviour 
when online. There are 4 sacred 
netiquette rules:  
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Popular abbreviations and shorthand: 
 
BTW = By The Way  
LOL = Laughing Out Loud  
ROTFL = Rolling On The Floor Laughing  
IMHO = In My Humble Opinion  
IYKWIMAITYD = If You Know What I Mean And I Think You 
Do  
JK = Just Kidding  
NP = No Problem  
WBS = Write Back Soon 
 

 
1. Consider email public 
information. Since messages can be 
easily leaked, write them 
professionally because you never 
know who will see them. Also, 
don‟t include offensive or 
misleading phrases in the signature 
that may go against your 
company's policy.  
 
 
2. Don‟t shout. Writing in capital 
letters means you're screaming in 
the digital world. That's not nice. 
So to emphasize a word, place 
*asterisks* on either side.  
 
 
3. Smile. Icons, such as 8), invoking 
a smile are okay to use and add 
personality. See Wikipedia for more 
emoticons examples1.  
 
 
4. Get to the Point. Email is 
supposed to increase efficiency. 
Write short paragraphs and edit 
messages.  
 

 
 

Mind your Netiquette  
E-mail prudence is becoming more important, as courts recognise e-mail messages as 
evidence. Keep in mind that for company-owned e-mail accounts, the company owns the e-
mail messages, not the employee. Thus, keep the following questions in mind when writing 
e-mails:  

• How would you feel if your boss read this e-mail?  
• How would you feel if this e-mail appeared in the newspapers?  
• What if the person you are referring to in your e-mail was in the same room?  
• How would you feel if you received this e-mail message?  
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GROUP ACTIVITY 1.1 

 
Your institution possibly also has additional netiquette rules. Find out what they might be. 
Now have a look at the following scenarios and decide whether they are examples of good 
or bad netiquette: 
 

SCENARIO 
GOOD 

NETIQUETTE 
BAD 

NETIQUETTE 

Joe receives an e-mail message from a colleague. He decides 
that it is appropriate to mailing list he subscribes to, and decides 
to pass it along. Before he does this, however, he writes to his 
colleague to receive permission. 

  

Monge uses a computer in an Internet Cafe where a number of 
people use the same computer. When she logs on, she 
discovers that the machine pulls up the previous person‟s e-
mail. „I know her , we're working on the same assignment," 
she thinks, "and I don't have time to change the configurations. 
I'll just use this account to see if there's any new information on 
the project‟. 

  

A group or organization has sent out e-mail to large quantities 
of people whether they have any interest in what is being 
offered or not. People enjoy receiving lots of mail, right? 

  

Sipho writes the following e-mail memo to his professor:  
 
PROF NCUBE -  
I HAVE RECEIVED YOUR LATEST EMAIL ON THE ICT MODULE 
PROJECT AND WOULD LIKE TO DISCUSS THE DEADLINES YOU 
HAVE SET FOR SUBMISSION. WOULD YOU HAVE TIME IN YOUR 
SCHEDULE TO MEET WITH ME THIS THURSDAY AT 11:00?  
THANK YOU,  
SIPHO 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Be aware of the changes communication 
inventions have undergone throughout the 
ages.  

  

Understand the relationship between the 
Internet, email and communication.   

Be aware of the advantages and disadvantages 
of email communication.    

Be aware of the different types of email.   

Be able to setup and use a webmail account.   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 

 

 

 

 

 
 
 
 
How will you do this? 
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Part 5: Communication 

SECTION 2: SOCIAL NETWORKING 

1. Introduction 
Social networking facilitates communication between individuals or organizations that share 
common interests, values, visions, ideas, ideals, financial exchange, friendship, or the like. 
Social networking is very popular online, because the internet is teaming with individuals 
who are looking to meet other internet users in order to develop friendships or business 
relationships.  
 
Social networking websites are often referred to as virtual communities, and these can 
attract members in the hundreds of thousands. Such social networking websites help people 
who have common interests communicate with one another; members are provided with 
tools to communicate, discuss issues, make recommendations, as well as upload resources to 
share with one another.  
 
In the early days of the World Wide Web institutions, used to publish materials for others to 
read on the web. It was all rather one-way traffic and it was difficult for end users to make 
queries or to talk to the publishers, let alone with other end users. Social networking sites, 
however, have overcome these barriers by using online forums, blogs or discussion list 
facilities. In fact, many of them have developed special applications or “apps“ that offer 
rather unique facilities. For example, you can send “virtual“ cakes or flowers for friend’s 
birthdays within FaceBook, add comments to other people’s photos in Flickr, or write book 
recommendations within Amazon. The best way to appreciate social networking is to get 
involved. This Section focuses on some of the most popular social networking sites. 

Learning Outcomes  
On completion of this Section, you will:  

• Understand the meaning of online social networking;  
• Understand the benefits and risks of participating in social networking sites; and  
• Join/subscribe to a number of social networking sites.  

 
 
 

2. Characteristics of Social Networking Sites  
There is certainly no shortage of social networking sites on the web, with new sites popping 
up almost every day. Therefore, you are bound to find one that appeals to you. But what is it 
exactly that differentiates a social networking site from a regular web site? According to the 
site, http://socialnetworking.lovetoknow.com, there are five basic characteristics of social 
networking sites: 
 

 

Online social networks are built and directed by users 
themselves, who populate the network with conversations and 
content. Anyone who takes part in the discussion can 
determine the direction of the content, making social 
networks exciting and dynamic for Internet users. 

 

The social network websites are often filled with network-
based gaming applications, chatrooms and forums. They also 
serve as entertainment and a way to connect and have fun 
with friends. 
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Social networks are founded on the fact that members hold 
common beliefs, hobbies, interests, etc. You can also discover 
new friends and reconnect with old friends via these interest-
based communities. 

 

Social networks thrive on relationships – the more 
relationships you have, the more established you are toward 
the centre of that network. 

 

Social networks provide users with emotional security and a 
sense that no matter what happens, their friends are within 
easy reach. Users can go online and communicate directly with 
a circle of friends, who can provide support. 

 
 
	
  

3. Risks of Social Networking  
As with most things in life, there’s are pros and cons associated with social networking. 
Some people are strong supporters of social networking, while others think it withdraws you 
from the real world. 

THE PROS:  
• Making new friends  
• Connecting with old friends  
• Finding romance  
• Forming new businesses  
• Finding property  
• Finding work  
• Receiving recommendations  

THE CONS:  
• Identity theft  
• Cyber-stalking  
• Internet addiction  
• Can waste time  
• You face exposure  
• Some information is permanent  
• Invasion of privacy  

 
Discuss these with your facilitator and your partner in class. It is important to weigh both 
opinions in order to thoroughly explore the advantages and disadvantages of social 
networking. 
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4. How to join a Social Networking Site 

 

Facebook is a social networking site 
that has attracted thousands of 
people all over the world, and is 
also a favourite of a large South 
African contingent. There are 
quizzes and tests, as well as 
numerous facilities to share 
information, such as photos, music, 
favourite films, books, etc. 

Register on facebook 
 

 

1 Go to www.facebook.com  
 

2 Enter your first name, last 
name, e-mail address, 
password, gender and birthday 
and click Sign Up.  
 

3 Complete the Security Check 
by filling in the given text in the 
text box provided and click 
Sign Up.  
 

4 Go to your e-mail account and 
look for a confirmation e-mail 
from Facebook and click on 
Complete Sign-­up.  
 

5 Complete the information 
under Step 1, 2 and 3 and click 
on Save and Continue.  
 

6 On the Welcome page you can 
then activate your mobile 
phone (section 4), find 
people you know (section 5) 
and control what 
information you share 
(section 6).  

 
 

Signing up Friends 
 

Just use Facebook Search to find 
the person you know and then click 
on the "Add as Friend" button to 
the right of their search listing. A 
friend request will be sent to that 
person. Once they confirm that 
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they actually are friends with you, 
they will show up on your Friends 
List. 

Writing messages on your friends’ walls 
 

 

The Wall is the center of your 
profile for adding new things, like 
photos, videos, notes and other 
application content. The Publisher 
at the top of your Wall allows you 
to update your status and share 
content through many different 
kinds of Wall posts.  
Facebook only lets you write on 
your friends' Walls and your own 
Wall. You can also write on the 
Wall of any Page you become a fan 
of.  
 
Click on any of your friends‟ 
profiles and select Wall. Write in 
the ‘Write something’ block 
provided and then click on Share. 
Whatever you wrote in the box will 
then show on that friend‟s wall. 

My Account and Help Center 
 

 

Should you have any problems with 
applications, click on Account and 
select Help Center. A screen will 
appear with various applications 
under Using Facebook, Facebook 
Applications and Features, and 
Ads and Business Solutions.  
Click on any of the items under 
these headings for assistance. 

 
 

 
GROUP ACTIVITY 1.2 

 
1 In groups, create your own rating scale (1-5) that you will use to assess a number of 

websites to determine if they can be classified as social networking sites or not.  
2 Visit the following sites listed below and rate each site based on the scale you have 

developed. Provide explanations for each rating you have provided.  
3 Identify some of the “cool” social networking features (if any) contained within 

each site.  
4 Your facilitator will then lead a discussion inviting feedback from each of the 

groups.  
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SOCIAL NETWORKING SITE: RATING SCALE 

1= 2= 3= 4= 5= 

 

 

Flickr www.flickr.com Rating: 

 

MySpace www.myspace.com Rating: 

 

News24.com www.news24.com Rating: 

 

Wikipedia www.wikipedia.org Rating: 
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Kalahari.net www.kalahari.net Rating: 

 

5FM Radio www.5fm.co.za Rating: 

 

Youtube www.youtube.com Rating: 

 

Iafrica.com www.iafrica.com Rating: 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Understand the meaning of online social 
networking;    

Understand the benefits and risks of 
participating in social networking sites;   

Join/subscribe to a number of social networking 
sites.   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 

 

 

 

 

 
 
How will you do this? 

 

 

 

 

 



  

 

Part 6: 
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Part 6: Research Skills 

SECTION 1: FINDING INFORMATION ONLINE 

1. Introduction 
In this Part, we are going to investigate ways to do research using computers and the 
Internet. You will be required to be able to search, find and analyse data, both for your 
studies, as well as in the world of work. Having access to the Internet and its vast resources 
makes this much easier than in the past. Previously we were bound to the information 
collected by institutional archivists and librarians, but now the Internet can provide access to 
a lot more information and also the latest information. However, you should not ignore the 
Resource Centre on campus or your local Library, both are still excellent sources of 
information and provide an environment that is conducive to learning and study.  
 
Here we will focus on using search engines to identify specific information that will be useful 
to our studies and assignment-writing. We will also look at a number of strategies to 
determine the usefulness and authenticity of the websites identified by the search.  

Learning Outcomes  
On completion of this Section you will be able to: 
 

• Conduct an advanced search using a search engine to find appropriate information 
on the Internet  

• Be aware of the possible dangers of using online search facilities  
• Have developed a preference to a particular search engine  
• Critically evaluate the usefulness and authenticity of the information provided by the 

individual websites identified within the search results  
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2. Search Engines  
Recently, there were over 15 billion websites on the World Wide Web. It is easy to find what 
you are looking for if you know the web address, but one is not always exactly sure what to 
search for and this is where search engines come in - they help you browse through the sea 
of content. Most search engines use the simple process of searching the Internet for 
instances of words or phrases that a user has inserted into a search field. If you click the 
“Search” button, millions of results are returned. However, not all search engines are the 
same; you need to find one that consistently returns results that suits you. 
 

Search Engine Description 

www.google.co.za 
 

 

Google is currently the most well-known and „trendy‟ search 
engine. People like it because it ranks sites according to 
popularity. It uses the number of links to a site to determine how 
important the site is. It places these sites high up in the returned 
search results. Google also has specialised searches for blogs, 
images, news, scholarly journals, patents and books. It is also very 
user-friendly. 

www.yahoo.com 
 

 

Yahoo is the „grandpa‟ of search engines and has built up a 
loyal community around it. The search facility appears at the top 
of the page and a portal filled with numerous services and 
content appears on the same page. Noteworthy features include 
shortcuts to dictionary, synonyms, patents, traffic, stocks, and an 
encyclopaedia. 

www.ask.com 

 

Ask uses a system called Subject-Specific Popularity™ ranking 
that allows you to suggest a broader or narrower search, thereby 
filtering your search results. It too has an encyclopaedia that is 
very useful. 

www.ananzi.co.za 
 

 

Ananzi is a South African-based search engine and specialises in 
finding local services and resources. There is also a handy map 
facility that shows you the street names for any district, town or 
city in the country. 

www.za.msn.com 
 

 

MSN is a popular search facility for those who use the Microsoft 
Network portal, MSN. In the USA, MSN search accounts for about 
10% of all Internet searches. There is a local version that uses the 
same technology. 

www.monstercrawler.com 

 

Monster Crawler is an example of a meta-search engine that 
coordinates searches using all of the top 5 US search engines 
(Google, Yahoo, MSN, Ask and AOL). While it might make sense 
that more heads are better than one, there are some academics 
that believe that the results returned by meta-search engines are 
no better than those sites using one system 
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3. Advanced Search Strategies 

Phrases and exclusion strategies  
 

1 Insert more than one word into the search field 
Using more than one word to describe what you are searching for forces the search 
to be more focused. The search engine returns results of web pages that contain all 
the words you have inserted and, therefore, are more likely to be close to what you 
are looking for. 

 
2 Insert phrases inside inverted commas 

Ensure the search engine searches for the instance of a phrase rather than a series 
of individual words by inserting phrases inside inverted commas like, such as 
“Search Engine”, “Virgin Active” and perhaps most significantly “South Africa”. 

 
3 Insert a minus sign and then the ambiguous word you want excluded 

This allows you to ask the search engine to exclude or omit instances of an 
ambiguous meaning of a word that you are looking for, e.g. glasses – spectacles 

 
 

ADVANCED SEARCH SCREEN 
Most search engines offer you access to a screen that contains a host of different search 
strategies that allows you to customise how you search. This screen shot belongs to the 
Google advanced search screen. Notice that it allows you to:  

 
1 Use exact or exclude various words  
2 Determine how new or old the 

page should be  
3 Identify where in the web page the 

key words should be found  
4 What geographic region or domain 

the page should come from  
5 What language the pages should 

be in  
6 If the resources you are searching 

for are not web pages, then you 
can also determine what type of 
file types you would prefer, e.g. 
PowerPoint or .ppt  
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4. Determining the Usefulness of the results  
While there are numerous resources available on the Internet, not all of them are accurate. 
Therefore, it is important to be able to judge which information is trustworthy and which 
should be ignored. Below is an introduction to evaluating web resources:  
 
You will need to evaluate each website according to the following five main criteria: 
	
  

Accuracy 
• Are the pages accurate?  
• First identify who or what institution wrote the page and ask yourself if 

this person or organisation is known to have relevance in this field? Also 
try to determine what the page’s purpose is. If it’s trying to sell a product, 
then you need question its accuracy.  

• Tip. Look to see if the author or company is contactable, if they leave an 
e-mail or telephone number. 

 
Authority	
  
• Does the site have any authority?  
• Anyone can publish on the web, which means that there are many people 

communicating on issues where they have factually unsupported views. 
So look to see if the website has any authority.  

• Tip: Look at the domain to determine if the organisation is academic or 
educational. The URL should contain, .edu or .ac for it to be one of these. 
Government URLs normally contain the domain, .gov.	
  

	
  
Objectivity 
• How objective is the information?  
• Many people express an subjective opinions that is not always backed up 

by fact. You need to look for objective sites that have evidence that 
supports the various outlooks on a praticular subject.  

• Tip: Determine if the page is really trying to promote something specific (a 
product, service or perspective) If so it might be biased. It’s probably a 
good idea to always be sceptical about a page and initially view it as an 
infomercial on TV. 

 
Up-­to-­date 
• How up-to-date is the information?  
• Spend some time determining if a site is up to date, as you will usually 

want the latest information.  
• Tip: Look for dead links. The existence of broken lines means the site has 

not been maintained and updated. Some sites have the date the page was 
updated at the bottom of the page. 

 
Coverage 
• How comprehensive is the coverage?  
• Some sites look wonderful, but once you start working though the 

information, you might discover that the information is superficial and 
suggest more than they actually tell you.  

• Tip: If the site wants you to use plug-ins to enhance the visual experience 
of the site, then ask yourself whether these are really necessary for your 
research. 
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GROUP LEARNING ACTIVITY 4.11 

 
Access and read the following three websites on Nelson Mandela and rank each one 
according to the 5 criteria outlined above. A score of 1 is poor and 5 is excellent. Also write 
a comment about the usefulness of the site for research purposes. 
 

WEBSITE, URL  
& GENERAL COMMENT ACCURACY AUTHORITY OBJECTIVE UP-TO-DATE COVERAGE 

SA History Online 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 

http://www.sahistory.org.za/pages/people/special%20projects/mandela/bio_1.htm 

General Comment: 
 
 
 
 
 
 
 

Nelson Mandela ThinkQuest 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 

http://library.thinkquest.org/C005803F/manhome.htm 

General Comment: 
 
 
 
 
 
 

Mandela: An Audio History 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 

http://www.radiodiaries.org/mandela/index.html 

General Comment: 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

                                            
1 See Feedback on page 8 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Conduct an advanced search using a search 
engine to find appropriate information on the 
Internet  

  

Be aware of the idiosyncrasies and possible 
dangers of using online search facilities   

Have developed a preference to a particular 
search engine   

Critically evaluate the usefulness and 
authenticity of the information provided by the 
individual web sites identified within the search 
results 

  

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 
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How will you do this? 

 

 

 

 

 
 
 

 
FEEDBACK: GROUP ACTIVITY 4.1 

 
 

WEBSITE, URL  
& GENERAL COMMENT ACCURACY AUTHORITY OBJECTIVE UP-TO-DATE COVERAGE 

SA History Online 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 

http://www.sahistory.org.za/pages/people/special%20projects/mandela/bio_1.htm 

General Comment: 
 
A very good site that scores highly in all categories. When I reviewed the site, it had not been updated 
to include his 90th birthday, even though this had passed some months previously. 
 
 

Nelson Mandela ThinkQuest 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 

http://library.thinkquest.org/C005803F/manhome.htm 

General Comment: 
 
This was in fact part of a secondary-school student’s ThinkQuest project on prominent leaders that 
included a page on Nelson Mandela. Its major failing is that it is not very comprehensive, so it scores 
poorly on ‘Coverage’, as it touches on his influence during his retirement, for example. It is, however, 
fairly accurate otherwise. 
 
 

Mandela: An Audio History 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 

http://www.radiodiaries.org/mandela/index.html 

General Comment: 
 
An excellent site, but is limited in that it focuses exclusively on the audio history that is available on the 
subject. It scores high on accuracy, authority and objectivity, but because there is a lack of audio files 
on certain aspects of his history, there are many gaps. It scores poorly on Coverage.  
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Part 6: Research Skills 

SECTION 2: ENCYCLOPEDIAS 

1. Introduction 
A good place to start your research is with an encyclopaedia. These are very important 
source of information, both in terms of your studies at university, as well as in the world of 
work. Encyclopaedias offer you a concise overview of a topic or subject. They centre on what 
is considered established fact and try to be as objective as possible. Your research will most 
likely also require you to search for and read articles that focus on the latest research and 
findings. These views and facts would not yet have been written into any encyclopaedia 
article.  
 
In this Section, we will focus on using three popular electronic encyclopaedias: 
 

 

Learning Outcomes  
On completion of this Section you will be:  

• Be aware of the uses of Encyclopaedias  
• Be able to access encyclopaedias in 3 different media: paper, DVD and online 

versions  
• Be able to use look up articles in each medium  

 
 



PART SIX: RESEARCH SKILLS 
 

 

 

11 

SKILLS FOR A CHANGING WORLD Let your future take flight 

2. Media of Encyclopaedia 

Books and Volumes 
 
Examples of well-­known sets of encyclopaedias:  
 

• Collier’s Encycolopedia  
• Harmsworth’s Encyclopaedia  
• The Children’s Encyclopedia  
• World Book Encyclopedia  
• Funk and Wagnalis  
• Jewish Encyclopedia  
• Academic American Encyclopedia  

 
The Encyclopædia Britannica is the most famous of these paper-based references, although 
there are many different publishers. Another popular title is World Book. Currently the latest 
version of the Encyclopædia Britannica includes 32 volumes! Generally, all articles are 
organised alphabetically, but the set is divided into a number of sections. The first section is 
a quick-reference set, while the bulk of the volumes are for in-depth references. An annual 
yearbook is released to update an existing set.  
 
There are many different sets of encyclopaedias available in libraries, aimed at different 
readers, such as young readers, scientists, religious scholars, etc.  
 
It makes more sense these days to update an encyclopaedia online; Britannica has also 
moved into this medium. A subscription service allows users‟ access to their database online. 
This version of the encyclopaedia contains the most accurate and up-to-date information. 
You can access the online version at www.britannica.com, but in order to use it properly, 
you will need to subscribe: 
 

 

1 Click on Sign up Now  
 

2 Click on Sign In / Register 
 

 
3 Fill in your e-mail address and select ‘I 

am not yet registered with The 
Britannica Store’  
 

4 Click on Submit  
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5 Fill in the information in the Add 

Billing Address window  
 

6 Click Register 

 
 

Internet 
Wikipedia is a well-known, online encyclopaedia which does 
not require subscription. Its 10 million articles are 
collaboratively written by volunteers around the world, and 
almost all the articles can be edited by anyone who can 
access the Wikipedia website. Because of this, some 
academics are concerned that the articles might not be 
objective and that the information might not be reliable.  
 
Therefore, it is important that you cross reference anything 
that you have located on Wikipedia before you include it in 
your research. 
 
Other online encyclopaedia include:  
 

• HighBeam Encyclopedia  
www.encyclopedia.com  

• Knol  
http://knol.google.com/k 
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Compact Disk or DVD 
Microsoft Encarta is a popular compact disk-based reference that 
incorporates multimedia (audio clips, photographs, animations and 
video) in amongst the text. It allows one to see visual examples and 
hear commentary or sounds, as well as read various articles. 
Hyperlinks embedded in the text makes cross referencing articles 
easy. Encarta now has a free online version available from within the 
MSN portal that incorporates a dictionary and Atlas.  
 
www.encarta.msn.com 
 
 
 

 
GROUP ACTIVITY 2.12 

 
Test the following free online encyclopaedias and do the same search for information on 
Nelson Mandela. To do this, look for the search field on each of the sites, type in the term 
(Nelson Mandela) you are interested in and click the „Search‟ button. The results will then 
appear on the screen  
 
Also, search for Kaiser Chiefs and see how similar or different the articles are. Make a 
comment about your experience and the usefulness of the encyclopaedia in the box 
provided and, once completed, rank the online reference sites. Note which do you prefer 
and would use in the future. 
 

 

HighBeam www.encyclopedia.com 
 
 
 
 
 
 RANK 

 

Wikipedia www.wikipedia.org 
 
 
 
 
 
 RANK 

 

Knol http://knol.google.com/k 
 
 
 
 
 
 
 RANK 

                                            
2 See Feedback on page 14 
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5. Tracking my progress 
You have reached the end of this section. Check whether you have achieved the learning 
outcomes for this section.  
 

LEARNING OUTCOMES  I FEEL CONFIDENT  I STILL NEED PRACTICE 

Be aware of the uses of Encyclopaedias    

Be able to access encyclopaedias in 3 different 
media: paper, DVD and online versions.   

Be able to use look up articles in each medium.   

Be aware of the uses of Encyclopaedias   

 
 
What did you like best about this section? 

 

 

 

 

 
 
What did you find most difficult in this section? 

 

 

 

 

 
 
What do you need to improve on? How will you do this? 

 

 

 

 

 
 
 
 
How will you do this? 
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FEEDBACK: GROUP ACTIVITY 2.13 

 

 

HighBeam www.encyclopedia.com 
 
This is a free, easy to use online encyclopaedia. This 
one supposedly has access to 200,000 articles from 
Britannica, Oxford University Press and Columbia 
Encyclopaedia. It successfully looked up the term 
„Nelson Mandela‟ and provided access to an 
accurate and accessible article on the politician. It, 
however, failed to find the soccer club „Kaiser 
Chiefs‟ but did link to a news article on the British 
pop band of the same name. 
 

2 
 
 
 
 

RANK 

 

Wikipedia www.wikipedia.org 
 
This is a free, easy to use online encyclopaedia. It 
found the term „Nelson Mandela‟ and provided 
access to a good article on the leader. It also found 
both the football club and the British band, Kaiser 
Chiefs, although it defaulted to the pop group first. 
Both articles were well written. 
 

1 
 
 
 
 

RANK 

 

Knol http://knol.google.com/k 
 
This is another free online encyclopaedia, organised 
by Google. It found the term „Nelson Mandela‟ 
easily and provided access to an excellent article on 
the leader. It failed, however, to find anything on the 
term „Kaiser Chiefs‟ except for a few minor 
mentions within other non related articles on the 
British pop band. 
 

2 
 
 
 
 

RANK 

 

                                            
3 See Feedback on page 14 
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